
Setting Up a Wiki
To set up a new wiki on PBworks:
1. Go to http://pbworks.com and click on the 

Sign Up link at the top of the page.
2. Select the Basic plan. This is the free plan 

that includes up to 2 GB of storage space.
3. Choose an address for your PBworks wiki 

and make sure to select the For education 
option. 

4. Using the pulldown menus, choose an 
education level (K-12, Higher Education, 
Nonprofit or Library) and purpose for your 
wiki (Collaborative Classroom, Library 
Workspace, Easy Website, or Other).

5. Enter your name, a valid email address 
and the password you wish to use for 
your wiki.

6. Click on Next. A confirmation email will be 
sent to the email address you provided. 
Open the email and click on the activation 
link to return to PBworks and continue 
setting up your account. 

7. Choose the privacy settings for your wiki 
(who can view or edit your wiki).

8. Check the box at the bottom of the page 
to indicate that you agree to the terms of 
service and click on the Take me to my 
workspace button.

9. Your new wiki will open with some 
placeholder text already added to the 
wikiʼs first page, which is also known as 
the FrontPage. To begin editing the wiki, 
click on the Edit tab at the top of the 
window. 

User Management
Once you have set up a wiki you can assign 
permissions that will determine the level of 
access visitors to the wiki site will have:
• Administrator: as the wikiʼs creator and 

owner, you are automatically assigned this 

role. This role allows you to add and remove 
users, change permissions and access the 
settings page.

• Editor: can rename and delete pages, files 
and folders. You should be careful in 
assigning this role as it allows the removal 
of content from the wiki.

• Writer: can edit pages and revert them to 
previous versions, as well as upload files 
and add pages. This is the recommended 
role for most of the people you will invite to 
work on the wiki.

• Reader: can only view content on the wiki 
and does not have the ability to make any 
changes.

• Page-level only: allows you to give 
someone up to Editor level permissions on 
a single page without giving them access to 
the rest of the wiki. 

To assign user roles:
1. While you are in View mode, click on the 

Settings link in the upper right corner of 
any PBworks page to open the settings 
page for your wiki.

2. Click on Users on the left side of the 
page.

3. On the right side, enter the email address 
of each user you want to add, select the 
role you want to assign to them from the 
Permission level pulldown menu and click 
on Add user. This will send out an 
invitation email to each user with a link to 
access the wiki.

Adding and Formatting Content
If you have been assigned the role of Writer, 
Editor or Administrator, you can edit the 
content on a wiki page as follows (you may 
have to log in and provide the wiki password/
invite key first):
1. Click on the Edit tab at the top of the 

page.
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2. If youʼre editing the FrontPage (the first 
page of a wiki) you should see some 
placeholder text. Select this placeholder 
text, press the Delete key on your 
keyboard to remove it, and replace it with 
your own text. On new pages you create, 
you should start out with a blank page.

3. Once youʼve entered your text, use the 
buttons in the toolbar at the top of the 
page to edit it as follows:
• Make the text bold, italic or underlined: 

select the text you want to apply the 
style to and click on the appropriate 
button in the toolbar.

• Add a list: click on the 
button for the type of list 
you wish to add (ordered or 
bulleted) and begin typing the text for 
your first list item. To add more list 
items, press the Enter or Return key on 
your keyboard. To add a line break 
without creating a new list item, hold 
down the Shift key as you press Enter 
or Return. When youʼre done creating 
your list, click on the list button in the 
toolbar one more time.

• Add indentation: place the 
cursor at the beginning of the 
line you wish to indent, then 
click on the Increase Indent button in 
the toolbar. To undo the indentation, 
click on the Decrease Indent button.

• Change the alignment: click on the left, 
center or right align button in the 
toolbar .

• Change the text or background color: 
click on the appropriate color button and 
select a color swatch from the pulldown 
menu.

• Change the font or text size: select the 
text you want to format and select a 
different font or text size using the 
pulldown menus in the toolbar.

• Add a heading: select the text you want 
to use for the heading and select a 

heading level (Heading 1 to Heading 6) 
from the Format pulldown menu.

• Remove all formatting: select the 
text you want to have all 
formatting removed and click on 
the Remove Formatting button.

• Undo the last edit: click on the 
Undo button in the toolbar.

• Add a horizontal rule to divide 
sections of text: place the cursor 
on a blank line and click on the 
Insert Horizontal Rule button.

4. Enter any tags (keywords) you want to 
associate with the page in the Tags field 
at the bottom of the page.

5. Click on the Save button when youʼre 
done with all of your edits.

Changing Wiki Settings
To view the settings for your wiki, click on the 
Settings link at the top of any of your wikiʼs 
pages. Not all of the settings can be modified 
on a wiki created with a free account. The 
ones you can modify are listed below:
• About This Space: allows you to change the 

title text that appears at the top of each 
page, enter a brief description of the wikiʼs 
contents, and change the contact email of 
the wikiʼs owner. This is also where you can 
specify the language and time used for your 
wiki.

• Colors: allows you to select a color scheme 
for your wiki.

• Workspace Security: allows you to 
determine if a wiki will be private or public. 
Checking the box next to Let people request 
access allows people visiting the wiki to 
request to be added as a user. Pending 
user requests will be listed at the top of the 
Users page in the wikiʼs Settings.

Uploading Files
You can upload up to 2 GB of files to your 
PBworks site. To upload a file:
1. Click on Upload files at the top of any wiki 

page, then choose Upload files when the 
Pages & Files page opens up.

2. Locate the file you want to upload on your 
computer, then click on Open. The 
uploaded file will be shown on the right 
side of the Pages & Files page.
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3. To rename the file youʼve uploaded, click 
on the Rename link below the file name 
and replace the current name with the 
desired name. To save your changes, 
click anywhere outside the file name text 
field.

4. To remove an uploaded file from the wiki, 
select the check box next to the fileʼs 
name and click on the Delete button on 
the Pages & Files page.

 
You can also upload files while editing a wiki 
page by clicking on the Images and files tab 
on the right side of the page and clicking on 
Upload files to locate the file you want to 
upload.

Adding Images
To add an image to a wiki page:
1.  Upload the image file (see the previous 

section).  
2. Click on the Edit tab to open the wiki page 

for editing and place the cursor where you 
want to add the image on the page.

3. Click on the image you want to insert in 
the Images and files tab on the right side 
of the page. This will add the image to 
your page. 

4. To resize the image, drag on the handles 
that appear when you select it on the wiki 
page. You can also reposition the image 
by dragging it to another location on the 
page.

Creating Hyperlinks
To add a link on a PBworks page:
1. Select the text you want to turn into a link.
2. Click on the Insert/Edit Link button 

in the toolbar.
3. Select the Link Type at the top of 

the Insert Link popup window:
• PBworks Page; select the page using 

the Page pulldown menu.
• PWworks File: select a file using the 

File pulldown menu.
• PBworks Folder: select the folder using 

the Folder pulldown menu.
• Web Page: select URL as the Link Type 

and enter the address of the page in the 
URL field.

• Email: enter the email address in the 
field at the bottom of the popup window. 

4. Click on OK to add the link to the page. If 
you need to edit the link, select the link 

text and click on the Insert/Edit Link 
button. This will open the Insert Link 
popup window where you can make your 
changes.

A quick way to add a link to another wiki page 
on your wiki site is by selecting the link text 
and clicking on the page you want to link to in 
the Images and files list that appears to the 
right of every wiki page while youʼre in Edit 
mode.

Inserting a Table
A table can be used to align text using 
columns. To add a table to any PWworks 
page:
1. Place your cursor where you want to 

insert the table.
2. Click on the Insert/Edit Table button 

in the toolbar.
3. Enter the number of columns and rows 

and the table width, and set other table 
options such the cell spacing (amount of 
space between cells) and the cell padding 
(amount of space between the text and 
the cell borders). 

4. Click on OK once youʼve set all of your 
table options to add the table to the page.

When you right-click (or Control-click on the 
Mac) on a table you will see the following 
options:

• Cell: add, remove and split cells. Choose 
Cell Properties to access more properties 
such as word wrapping, vertical and 
horizontal alignment of cell contents, and 
background and border colors.

• Row: add and remove rows.
• Column: add and remove columns.
• Delete table: removes the table from the 

page.
• Table Properties: opens the same 

properties as when you click on the Insert/
Edit Table button in the toolbar.
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To resize a table once youʼve added it to the 
page, drag on the handles that appear when 
you select it.

Adding and Managing Pages
You can add multiple pages to your wiki, thus 
creating a wiki site. To add a page:
1. Click on Create a page in the upper left 

corner of any wiki page.

2. Enter a name for the new page in the text 
field at the top of the screen.

3. To base your page on a PBworks 
template, click on “more options”, select 
“Use a template” and choose the template 
from the pulldown menu.

4. Click on Create page and begin editing 
the new page. Make sure to click on Save 
when youʼre finished to add the page to 
the wiki site.

To view all the pages on your site, click on 
Pages and Files on the right side of any wiki 
page and select All Pages. This will show you 
a list of all the pages along with the time and 
date of the last revision.  

To remove a page from your site, check the 
box next to the name of that page on the 
Pages & Files page and click on the Delete 
button. To rename a page, click on the 
Rename link below that pageʼs name, enter 
the new name and click anywhere outside the 
page name text field to save your changes.

The Sidebar is a special page on your wiki 
site that appears embedded on the right side 
of every other page. The Sidebar can be used 
to add navigation for your wiki by placing links 
to all the other pages on the wiki site. Click on 
the Edit the sidebar link at the bottom of the 
Sidebar to open it for editing just as you would 
any other page.

Organizing Wiki Site Files
As your wiki site grows, you may find it helpful 
to organize your pages and other files into 
folders, just as you probably organize files on 
your computer. 

To create a new folder on your wiki site:

1. Click on the Pages & Files link at the top 
of any wiki page.

2. Click on New and choose Create a folder.
3. Enter the desired folder name and press 

Enter (or Return) on your keyboard.

To place a page in a folder, click on the Put 
this page in a folder link on the right side of 
the page, then choose a folder name from the 
pulldown menu. 

To remove the page from the folder:
1. Click on the Pages & Files link at the top 

of any wiki page.  
2. Click on the name of the folder on the left 

side of the screen to view all the pages in 
that folder.

3. Check the box next to the name of the 
page you want to remove from the folder 
and click on Move.

4. Select “Remove from (folder name)” in the 
popup window and click on Move. 

Another way to remove a page from a folder is 
by moving it to a different folder by clicking on 
the Put this page in a different folder link on 
the right side of the screen and choosing the 
desired destination folder using the pulldown 
menu.

To rename or delete a folder, go to the Pages 
& Files page, select the folder on the left side 
of the screen, and click on either the Rename 
folder or Delete folder button. 
 
Revisions
PBworks keeps track of every change you 
make to the wiki to make it easy to go back to 
a previous version if you make a mistake. To 
view the most recent activity on the entire 
wiki, scroll down the page until you see the 
Recent Activity section on the right side of the 
screen. This section will display the most 
recent changes made to the wiki. 

To view a list of all revisions for a page, first 
click on Pages & Files on the right side of the 
screen, then click on the link under Revs for 
the page you wish to review (the link will be 
the number of revisions). Next, click on the 
date and time of the revision you wish to view. 
This will open the page as it appeared at that 
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time. To save this version of the page, click on 
Revert to this version at the top of the screen. 
To return to the most recent version of the 
page, click on the View current version link. 

In the Revisions page you can delete 
individual revisions by clicking on the red 
Delete button to the right of each revision. You 
can also compare two revisions by making a 
selection with the radio buttons on the left and 
clicking on the Compare button. The two 
revisions will be shown in different text colors 
so you can tell them apart.

Extending Wikis with Plugins
PBworks plugins can be used to add videos, 
slideshows, calendars and more. To add a 
plugin to a PBworks page:
1. Place your cursor where you want to add 

the plugin on the page.
2. Click on the Insert Plugin button in the 

toolbar. This will open the Insert Plugin 
popup window. 

 

3. Click on a category to see the plugins 
available under that category.

4. Click on the link for the plugin you wish to 
add to your page.

5. The remaining steps for adding the plugin 
will vary depending on the plugin you 
choose, but you should see a Preview 
button that will allow you to preview how 
the plugin will appear on the page before 
you insert it. If youʼre happy with the 
results, click on OK to add the plugin to 
the page.

To resize a plugin once youʼve added to the 
page, drag on the handles that appear when 
you select it.

Sharing a Wiki
In addition to inviting other people to become 
users, there are two other ways you can share 
a wiki: 
• using the wikiʼs RSS feed.
• by sharing the print version of a wiki page.
 
By subscribing to the RSS feed for a wiki, 
other people can track the latest updates to 
the wiki. To view the RSS feed for the wiki, 
click on the RSS feed link at the bottom of any 

page. The RSS feed will display correctly if 
youʼre accessing it with a web browser that 
can read RSS feeds. To share the RSS feed, 
copy the URL in the browserʼs web address 
field and paste it into an email or add it to your 
website.

To save a print version of any wiki page, click 
on the Printable version link at the bottom of 
the page. 

This will open a ready-to-print version of the 
page in your web browser without all of the 
PBworks buttons and links that normally 
appear on the right side and bottom of the 
screen.

Tags
Each PBworks page can have several tags 
associated with it. Tags are similar to 
keywords and can help you find a page when 
you canʼt remember its exact title. To add a 
tag to a page, click on the Add Tags link on 
the right side of the screen. You can add 
multiple tags at once by separating them with 
a comma.

To search your PBworks site using a tag, type 
the word tag followed by a colon and the 
name of the tag. For example, to search a 
PBworks site for all pages tagged with the 
word homework, you would type 
“tag:homework”. 
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